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Introduction 
 

Welcome to the guide for the Adobe Photoshop CC plug-in “Astro Panel” version 5.0. 

This plug-in has advanced features to drastically reduce the workflow of the amateur 

photographer, the professional photographer and the video maker in a matter of 

minutes. The workflow illustrated in this guide together with the description of the 

functions will help you to reach high quality digital processing. The functions integrated 

inside the panel will guide the user during the digital processing process because they 

are arranged in chronological order to instruct him in a correct digital post-production 

method. Astro Panel now integrates the advanced features of Fusion.  

"Astro Panel" is entirely in HTML5 and was created in collaboration with qualified 

expert personnel to maximize the experience of use and make the integrated functions 

fantastic. 

"Astro Panel" is not compatible with the versions of Photoshop CS, but only from the 

CC 2015 version up to the current CC 2020. The compatibility with the CC version of 

Photoshop is used to guarantee excellent performance and continuous updates. To 

take full advantage of the plug-in's features, I recommend you always update Adobe 

Photoshop CC to the latest version available. 

Let's move on to installing the plug-in in our PC / MAC. 
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How to Install? 
 

To install the Panel on your PC you can use Anastasiy Extension Manager. We need to 

download the Anastasiy Extension Manager from the website 

https://install.anastasiy.com and perform these simple steps:  

- Select your operating system from the page;

 

- save the Zip ExtensionManager_win.zip in a folder;  

- Extract the files into a folder; 

- run the ExtensionManager file contained in the compressed package; 

- from the list of Adobe applications select Photoshop CC and then INSTALL; 

https://astropanel.it/
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- extract the panel files in a folder on your PC, select 

“it.angeloperrone.astropanel.v5.zxp” 
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Once the package is installed on your PC, from Adobe Photoshop CC open the menu 

"Window" -> "Extensions" and click on "Astro Panel 5". 

 

If you are upgrading from old version to 5.0, you will have to uninstall the old version 

and install the new one again using the Anastasiy extension manager using the 

"Remove" command.  
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Here is the video installation tutorial: 

https://www.youtube.com/watch?v=426V8ULLbPA&t=169s 

 

If you have problems installing Astro Panel try to perform a manual installation. 

Open the file you downloaded from the Astro Panel website and copy only the folder 

named it.angeloperrone.astropanel contained in the "Manual Installation" folder in 

one of these folders, depending on the operating system: 

Win: C: Program Files (x86) Common Files CEP extensions 

Mac: / Library / Application Support / Adobe / CEP / extensions 

After this, open Adobe Photoshop CC and verify that the panel is present on the 

Window -> Extensions.  

https://astropanel.it/
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The Plug-in 
 

With the latest update, many new features have been introduced regarding the 

experience of using Astro Panel. Once started in we will find four main sections with 

the relative dedicated functions: 

- The “LANDSCAPE” section dedicated to the post-production of the images has been 

completely renewed. Now the functions integrated in this tab adapt to any type of 

photography. You will be able to process white balance and color tone with one click, 

remove digital noise and annoying hot pixels, increase image sharpness, recover 

shadows and highlights, and handle many effects such as Orton and Glow; 

- The "ASTRO" section is dedicated to the post-production of astronomical images. The 

Astro section has been redesigned with the addition of new features and simplified to 

accelerate the workflow of astronomical images (milky way, startrail and deep sky); 

 - The "EXPORT" section integrates the tab for resizing images for the web, for saving 

files and for printing; 

- With the latest update, the “FUSION” section has integrated a new “Deep Sky” tab 

with which file sessions by channel and color can be added. 

The brightness, color and hue masks have been moved down to be available whenever 

you need them during your workflow. This section also integrates the advanced 

selection of luminosity masks in real time via the eyedropper positioned on the right. 

There are also sliders for controlling Adobe Photoshop layer masks. 
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The image above shows all the sections of the update to version 5.0.

 

Let's illustrate the various functions of "Astro Panel" section by section. 

https://astropanel.it/
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The LANDSCAPE Section 
 

The PRO section has been completely revised to contain all the new Astro Panel 

functions. From this section we can modify any type of photography, from 

astrophotography to the daytime landscape. 

We describe the commands of this 

section one by one. 

COLOR CORRECTION, are controls for 

color correction, white balance and 

color saturation, precisely: 

- COLOR, adjusts the automatic color 

corrections of the image; 

- TONE, adjusts automatic corrections 

of image tones; 

- BALANCE, find the average neutral 

color of an image and adjust the values 

of the range (half tones) according to 

this neutral color; 

- LAB, increases the vividness of colors 

in Color Lab. 

The IMAGE CORRECTION commands 

are for correcting artefacts and defects 

that affect all digital images: 

- REDUCE NOISE: helps the user to 

reduce the chromatic noise present in 

the photo without losing details and 

maintaining the nuclei of the nebulae 

and the brightness of the stars; 

https://astropanel.it/
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- REMOVE HAZE: removes the haze present in the photo and can be adjusted through 

the opacity of the layer; 

- ABERRATION: analyses chromatic aberrations and with the brush the user can remove 

the aberrations present in the image; 

- BANDING: banding or scaling is the phenomenon in which the shades of colours in an 

image are rendered as bands of colours. This function easily removes these defects. 

HOT PIXEL is a set of functions to automatically remove "Hot Pixels": those annoying 

white or coloured pixels that typically appear when taking pictures in low light and with 

long exposure times. Click on one of the coloured buttons to increase the intensity of 

the function. 

SHARPNESS is a group of semi-automatic functions that increase image sharpness. 

Let's analyze the commands: 

- BOOST: this very useful function in daytime images increases sharpness by using 

brightness masks (highlights and shadows); 

-  The HIGH PASS filter works on the contrast of the edges of the objects and you 

can adjust the ideal radius during post-production. I advise you to use it with 

caution in order not to exaggerate with the sharpness; 

- SUPER SHARP uses the "Advanced Sharpness" filter adjustable during post-

production and exercises greater control over the sharpness of the images; 

- LAB PRO increases the sharpness of the image on the "Luminosity" channel 

working in Color LAB. 

RECOVERY  is a set of automatic functions to recover lights and shadows in a single 

click. Click on 1 or 2 to choose the ideal intensity for your photo. 

EFFECTS , as the word itself says, adds effects to our images to improve the final result 

or give that touch that is missing. We find: 

- CONTRAST  selectively increases micro-contrast in the photo; 

- VIGNETTE  adds vignetting and it is adjustable at will; 

- EXPOSURE adjusts the final exposure of the photo and it is useful before 

publication on the Web or the printing phase.  

- FALL COLORS, transform the photo with autumn colors; 

- DARK MOOD, darkens the image; 

https://astropanel.it/
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- NIGHT, transform the photo from day to night; 

GLOW EFFECTS, contains four adjustments to create the final Glow effect on your 

photo. You can choose between: 

- SOFT: to create a light Glow effect; 

- - PRO, creates a professional and freely adjustable Glow effect with the channel 

mixer; 

- NIGHT: to create a Glow effect suitable for night images. 

ORTON EFFECTS contains four adjustments to create the final Orton effect on your 
photo. You can choose between: 

- BASIC: to create a light Orton effect; 

-  PRO, creates a professional and freely adjustable Orton effect with the channel 
mixer; 

- MAGIC, creates a fairy tale Orton effect; 

D&B EFFECTS, the Dodge and Burn, is a photographic technique entirely dedicated 
to light management. Through these functions you can "dodge and burn" your image. 
We have two different functions: 

- D&B - SIMPLE gives us the possibility to intervene on the dodge and burn using 
a black / white brush to obtain the desired effect; 

- D&B PRO automatically creates an aggressive dodge and burn working on the 
light masks and can be adjusted at the end. 
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The ASTRO Section 
The Astro section has been completely revised and now contains many more features 

than the previous version. 

We list all the functions in detail. 

AUTOMATIC PROCESS: this group contains two 
automatic functions that transform your 
astronomical photo in just one click. Two functions 
are available: 

- UNDEREXPOSURE - Automatic process Dark 
Images, (for underexposed or dark images); 

- OVEREXPOSURE - Automatic process Bright 
Images, (for images with correct exposure).

   

Automatic process example (Automatic process Dark Images). 

 

 

STRECHING IMAGE is a group composed of two commands that serves to extrapolate 

the hidden signal of the Milky Way / Deep Sky contained in the photo; there are two 

methods of extrapolation based on the exposure of the photo (bright or dark image) 

UNDER, fir underexposed images, and OVER, for overexposed images. Moreover, we 

have the DYNAMIC (Dynamic Strecth) mode, which amplifies the Milky Way signal or 

deep sky objects. 

https://astropanel.it/
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Example of  Dynamic Strecth 

 

STARS, there are three groups of functions that do different work on the stars. They 

are used mostly in Deep Sky images to highlight deep sky objects and turn off the 

brightness of stars. 

With the SELECT STARS group we can select stars based on their size. 

With STAR TOOLS we can make some particular changes such as: 

- FILTER - Star Filter: with it, you can filter the stars contained in the image and in 

small percentage turn them off in order to emphasize the nebulae. You can use 

this function as many times as you need to filter as many stars as possible; 

- FADE - Feather Stars: blurs the sharpest images to bring out the colors of the 

stars; 

- VIVID - Saturate Color Stars: it increases the vividness and saturation of stars; 

- REDUCE - Reduce Stars Diameter: it reduces the diameter and makes the stars 

in the image point-like; 

- REMOVE - Remove all Stars eliminates all the stars from the image leaving all the 

nebulosity of the objects of the deep free sky. 

https://astropanel.it/
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Example of Remove Stars (Stars have been partially removed to emphasize nebulosity). 

With the STAR SPIKES group we can create tips to the stars artificially. 

 

 

Esempio di Star Spikes Large (Vengono aggiunti gli spikes solo alle stelle più grandi). 
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ENHANCE-SHARPNESS is a set of commands used in astrophotography. Let's analyze: 

- NEBULA - Enhance NEBULOSITY amplifies the nebulosity of the Milky Way or 

deep sky objects, reducing the diameter of the stars; 

- BOOST - Precision Boost allows to increase the sharpness of the photo in a 

controlled way. It is advisable to use the white brush on the black level mask to 

increase the effect of the chosen command; 

- AUTOBOOST - Automatic Precision Boost increases the sharpness of the photo 

automatically; 

- EXTREME – Deconvulation: is a technique used in astrophotography that serves 

to give a hyper-sharpness to our photos. Adjust the opacity of the layer to your 

liking. 

   

Example of combining "Nebula" and "Boost" 

 

HOT PIXEL STARS, this set of functions automatically removes even the "Hot Pixels", 

those annoying white or colored pixels that typically appear when taking photos with 

little light and with long exposure times. Click on one of the colored keys to increase 

the intensity of the function. 

 

https://astropanel.it/
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DEEP SKY, contains three groups of functions designed specifically for deep sky images. 

The first is COLOR BALANCE,  a set of tools for color management. We can adjust the 

color temperature on the fly and correct the chromatic aberrations around the stars: 

- CAST - Remove Green color  Cast,  removes the green dominant contained in 

astronomical photos automatically and you can adjust the opacity to your liking; 

- LAB, saturated the image by 20% using the LAB colormethod; 

- RED – Selective Color Red, brush the red color contained in the image; 

- GREEN – Selective Color  Green,  brushes the green color  contained  in the 

image; 

- BLUE – Selective Color  Blue,  brushes the blue color contained in the image; 

- PLUS – Saturate and Sharpen,  accentuates the saturation and sharpness of the 

Milky Way or deep sky objects; 

The second group is DEEP SKY,a set of functions that enhance the image: 

- RELIEF, highlights the details of the photo; 

- DETAILS, accentuates the detail; 

- BLACK SKY, makes the bottom of the image darker; 

- BOTTOM, improves the bottom of the image; 

- FALSE Ha, create a level He fake; 

- FALSE Oiii, create a fake Oiii level; 

- HALOS, eliminate the bright halos around the stars. 

FALSE FLAT (REMOVE GRADIENT), the third group, automatically removes, in two 

steps, the "unpleasant" gradient that we find in our astronomical photos. There are 3 

commands that differ from each other based on the amount of gradient we want to 

remove. We don't need external software to do this because it's all integrated into 

"Astro Panel". 

https://astropanel.it/
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Example of False Flat 50% (press "1" and then the 50% button). 

 
Example of color and detail correction in lights and shadows 

https://astropanel.it/
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The last section concerns some functions explicitly designed for images with 

STARTRAILs. In this section you can remove the moiré from the images, make your 

skis fluid or saturate the color of the images. 

In the TONALITY  section you can adjust at will which shade fits your image. 

 

  

https://astropanel.it/
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The EXPORT Section 
The EXPORT section has also been completely redesigned and now contains many 
more features than the previous version. 

We list all the functions in detail. We have the ability to resize images at will for both 
local saving, printing or web. In 
addition, we also find a convenient 
function to add the watermark to our 
image before posting on social media. 

Another new feature of the new 
update is the ability to resize images as 
desired either for saving locally, for 
printing or for the web. In addition we 
also find a convenient function to add 
the watermark to our image before 
posting on social media.  

Other convenient features that 

immediately catch the eye are the 

quick adjustments. In fact we would no 

longer need to adjust the opacity of 

the layer, the nuance and density of 

the mask because we could do it 

directly from the panel below. Under 

these adjustments, the quick tools like 

Forward and Back, the Quick White 

Mask, Curves and Levels, White Brush 

and Black Brush, Hue / Saturation and 

Color Balance have been optimized 

compared to the previous version. 

As for the management of masks At 

the bottom we   have   luminosity 

masks, color masks and tonal color 

masks divided by Lights, Midtones  and   

Shadows. 

https://astropanel.it/
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On the right we have the dropper that allows us to query any area of the image and in 

real time understand which brightness mask to use. In fact, one of the masks will light 

up in light blue.  

Above the masks you will find some commands that will help you finish the masks:  

- END, to finish the selection of mask with the Curves layer; 

- DESELECT, to clear the selection (Ctrl+D); 

- INVERT, to reverse the selection; 

- APPLY, to confirm and paste the mask selection into our Photoshop layer. 

  

https://astropanel.it/
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The FUSION Section 
 

This tab is a concentrate of technology and a novelty for Astro Panel. Indeed, it 

integrates all the features of the Fusion plug-in reviewed and updated with new 

features. The Fusion tab is divided into four main sub-sections with the relative 

dedicated functions: 

- The "MERGE" section contains the most common types of image fusion developed 

from scratch and with proprietary code to speed up image summing operations; 

- The "STARTRAIL" section adds up to hundreds of images to obtain beautiful linear 

Startrails with particular effects on the stars; 

 - The "SKY STACK" section allows you to sum up images of the Milky Way and the deep 

sky very quickly. You can insert light frames, dark, bias and flat fields; 

- The "SKY HDR" section is one of the most advanced features of Fusion and blends up 

to 3 different exposures in one to achieve a dynamic range at night without equal; 

- The "DEEP SKY" section allows you to add multiple channels to get the final color 

image we want. 

Let's illustrate the various functions of the "Fusion Section" section by section. 

 

https://astropanel.it/
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The MERGE Section 
 

The Merge section allows us to sum lots of images to create a beautiful "SILK" effect 

that can be obtained even without the use of ND filters. Not only that, you can blend 

images to achieve Focus Stacking, combine beautiful images in Classic HDR and NIGHT 

HDR (multi-exposure at night). 

Here is the list of the description of the commands: 

LOAD FILES: This button allows you to select the files to be merged to obtain the silk 

effect. 

 

GENERIC ALIGNMENT: This switch activates the automatic alignment of the levels, the 

one accessible to all in the section Edit> Automatic level alignment, and automatically 

finds the alignment method. [Tip: when using this alignment method, it is 

recommended to also activate the lens correction for a better result] 

 

TRIPOD ALIGNMENT: This switch does the exact same thing as the generic alignment 

switch, but as an alignment method it uses ''Reposition'' instead of ''Automatic''. 

 

LENS CORRECTION: This function allows you to open files by applying the distortion 

and vignetting correction available within the Camera Raw plug-in. 

 

CHROMATIC ABERRATION: With this function we can also activate the removal of 

chromatic aberrations, also available in the Camera Raw plug-in. 

 

SILK: Clicking this button starts the fusion to create the desired silk effect. 

 

FOCUS STACKING: Clicking this button starts the fusion to create the Focus Stacking. 

Focus Stacking is a digital photographic technique that involves performing a series of 

shots of the same frame, each on a different focusing plane in sequence, in order to 

obtain a final image with a depth of field greater than that obtainable with traditional 

techniques. 

 

HDR and NIGHT HDR: HDR photos are used to capture scenes with a wide dynamic 

range. Click on the HDR button to add day images or NIGHT HDR for night images. 

https://astropanel.it/
https://angeloperrone.it/


24 

astropanel.it - angeloperrone.it 

MEAN STACK to sum images of the same subject and obtain a single "clean" final 

image of color and digital noise. 

 

The STARTRAIL Section 
 

Here is the description of the commands: 

 

LOAD FILES: This button allows you to select the files to be merged to get the startrail 

effect. 

 

TRIPOD ALIGNMENT: This switch activates the automatic alignment of the levels, the 

one accessible to all in the section Edit> Automatic level alignment, and automatically 

finds the alignment method. [Tip: when using this alignment method, possibly also 

activate the lens correction for a better result] 

 

COMET STAR EFFECT: This switch allows you to activate the fusion with the falling 

star effect. 

 

ROTATION DIRECTION: This switch allows you to activate the fusion with the falling 

star effect. 

 

LENS CORRECTION: This function allows you to open files by applying the distortion 

and vignetting correction available within the Camera Raw plugin. 

 

CHROMATIC ABERRATION: With this function we can also activate the removal of 

chromatic aberrations, also available in the Camera Raw plugin. 

 

BLEND: Clicking this button starts the merger, and at the end of it a message will 

appear that will show the time taken for the merging process of the shots. 
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The SKY STACK and SKY HDR Sections 
 

Here is a list of the description of the commands: 

LIGHT: This button allows you to select the light files to be merged. 

DARK: This button allows you to select the dark files to be merged. 

BIAS: This button allows you to select the bias files to be merged. 

FLAT: This button allows you to select the flat files to be merged. 

 

While the last three may or may not be selected, the light files must always be selected. 

 

ALIGNMENT: With this switch you can activate the alignment of the levels, and it's the 

one available on Photoshop in File> Automate> Photomerge. Its accuracy is good but 

approximate. If the photos are not aligned correctly, they are discarded. 

 

DUAL PASS ALIGNMENT: With this switch it is possible to activate the second alignment 

step. Activating this function, in fact, the photos will be aligned in an approximate way 

through the automatic alignment of Photoshop, to then be aligned to the maximum 

precision in a second step (with the maximum tolerance set in the slider "ALIGNMENT 

PRECISION"). This alignment algorithm is proprietary and is not present in any other 

Photoshop function. 

 

ALIGNMENT PRECISION: With this slider you can change the accuracy of the alignment. 

The recommended value is 3 pixels, as an ideal compromise between precision and 

alignment speed. The lower the pixel value, the greater the accuracy but also the time 

required for alignment. 

 

MAX ALIGN RADIUS: With this slider you can change the maximum radius in which you 

can align two images. If the set value is for example 15 pixels, the maximum possible 

alignment distance will be 15 pixels. 

If the photos are not aligned correctly, they are discarded. 
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AREA WIDTH: With this slider you can change the width of the selection area. This 

command must be used keeping in mind that the greater the size of the area, the 

greater the calculation time necessary for each iteration of the DUAL PASS ALIGNMENT, 

in favor of precision. 

For a normal 24MPX photo, the recommended approximate size is 150/250px, but if 

possible it is always better to prefer a larger area than necessary rather than too small. 

 

LENS CORRECTION: This function allows you to open files by applying the distortion and 

vignetting correction available within the Camera Raw plugin. 

 

CHROMATIC ABERRATION: With this function we can also activate the removal of 

chromatic aberrations, also available in the Camera Raw plugin. 

 

ALIGNMENT HELPER: In some cases, it may happen that the alignment of Photoshop 

fails to correctly process the alignment of the images due to particular lighting 

conditions. With this switch it is possible to favor alignment by performing 7 maximum 

attempts by varying some parameters. In this way, if without the help of the Alignment 

Helper a good part of the photos were discarded at the end of the elaboration, it is 

possible to repeat the fusion activating this function, allowing with good probability 

also to align the images that had otherwise been rejected. 

 

THRESHOLD: This slider allows to act on the threshold parameter of the DUAL PASS 

ALIGNMENT. If you don't know its impact in depth, it's always best to keep it at 128. 

It's an advanced command that allows the user to set the threshold to extract stars 

from the sky. For underexposed photos it may be necessary to bring this value to the 

left, while for overexposed photos to the right. 

It should be used sparingly, with the aim of making the alignment stars more evident. 

To set the optimal value, simply click the "PLACE" button under the "ALIGNMENT 

ZONE" item, click on the selection with the right mouse button and select "Deselect" 

(or for the more experienced click the CTRL + D keyboard shortcut for the Windows 

users or COMMAND + D for Mac users), then go to Image> Adjustments> Threshold, 

and move the slider so that you see the stars in a defined way, but avoiding artefacts 

such as stars that should be round that become deformed white spots etc. Perfection 

https://astropanel.it/
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would be a big star that can be made as round as possible. Then, once you found find 

the best value for you, keep it in mind, and after clicking Cancel (or possibly OK, it is not 

important), you can set that value correctly on the "THRESHOLD" slider. 

If you have not previously selected the alignment area you will have to click the "PLACE" 

button again and then when you have finished, click on "CONFIRM", or if you have 

previously selected the area, you can trivially close the document. 

 

PLACE: This button allows you to load the first photo selected in the Light item and then 

position the alignment area in the most appropriate way. 

The positioning of the alignment zone must be done with a very precise criterion, it 

must be centered on the largest possible star. In addition to selecting the Dual Pass 

alignment area, it can be used to immediately load one of our photos, so as to find the 

most appropriate threshold value based on specific needs. 

 

CONFIRM: At the end of the positioning, it will be enough to click this button so that 

the position of the area is recorded and applied during the processing. 

 

START: With this key it is possible to start the Stacking process. 

 

RESET: This button has the function of resetting the values of all the sliders to the 

default values. 
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La Sezione DEEP SKY 
 

In this section you can add several files per channel and get the final color image 

automatically. In fact Astro Panel is able to determine based on the files you enter 

what sum to make. 

We can add files R G B,  L RGB, L R G B,HA (R) OIII (G) SII (B), HA RGB. 

ALIGNMENT: With this switch you can enable channel alignment.   

 

ALIGNMENT TYPE: With this switch you can enable channel alignment on automatic or 

shift. 

 

ALIGNMENT CYCLES: With this slider you can change the accuracy of the alignment. 

The recommended value is 3 pixels, as an ideal compromise between accuracy and 

alignment speed. The lower the pixel value, the greater the accuracy but also the time 

it takes to align. 
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Tutorial Merge (Silk, Focus Stacking, 

HDR, Night HDR and Mean Stack) 
 

In this tutorial we will explain how to 

best use the MERGE section to 

achieve a beautiful Silk Effect, Focus 

Stacking, HDR or Night HDR. The 

operation is the same for all four 

casting methods. 

For this tutorial, we use a series of 

night files to upload as "NIGHT HDR". 

The first button to press is "LOAD 

FILES" to upload our photos. Once 

selected we must choose the type of 

alignment we want between 

"GENERIC" or "TRIPOD". We refer you 

to page 28 to discover the differences 

between the two commands. We 

choose "TRIPOD" (repositioning 

method) and active "LENS 

CORRECTION" to correct lens 

distortion and "CHROMATIC 

ABERRATION" to correct chromatic 

aberrations. 

Once all the parameters have been 

set, I press the "NIGHT HDR" key and 

wait for the final processing. 
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The RAW used for this test  were kindly sent by Andrea Consuele 

The end result is a layer as an advanced object so that you can modify the parameters 

again in Adobe Camera Raw (see the image above). 

This procedure is the same for the other types of fusion of the shots and the result 

obtained by the fusion can be enhanced and modified with the features present in the 

PRO section. 
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Tutorial for Startrail 
 

Now let's illustrate how to merge images to create a Startrail. The procedure is similar 

to that of the MERGE form. 

The first button to press is "LIGHT" to 

load the Startrail light frames. If 

available we can also load Dark, Bias 

and Flat frames. Once you have 

selected the photos to upload, we 

must activate the “TRIPOD 

ALIGNMENT” alignment. This switch 

activates the automatic alignment of 

the levels, the one accessible to all in 

the section Edit> Automatic level 

alignment, and automatically finds the 

alignment method. 

In the Stratrail tab we can also apply 

the "COMET STAR EFFECT" effect to 

give an effect to the stars streaked 

with shooting stars or to reverse the 

direction of the startrail using the 

"ROTATION DIRECTION" switch. 

We activate "LENS CORRECTION" to 

correct lens distortion and 

"CHROMATIC ABERRATION" to correct 

chromatic aberrations. 

Click on BLEND to start the image 

fusion and wait for our Startrail. 
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Tutorial Sky Stack – Sky Stack HDR 
 

In this tutorial we will explain how 

to stack images of the Milky Way 

or the deep sky using the Sky 

Stack and Sky Stack HDR section. 

 

The difference between the two 

types of merger is in the file 

upload. In the first type we will 

only add files that have a single 

exposure while in the second we 

can add more files with different 

exposures (different times or 

ISO). We can also load dark, bias 

and flat to increase the final 

quality of the file. 

 

Before starting the fusion of the 

images, we can edit all our files in 

Adobe Camera Raw without 

opening them in Photoshop CC 

(just click on the CLOSE button of 

Adobe Camera Raw) to generate 

the XMP files that will be read by 

Fusion. In this way we could for 

example correct the color or 

white balance of our images to 

have a correct final result. 

 

 

 

After this introduction and after 

https://astropanel.it/
https://angeloperrone.it/


33 

astropanel.it - angeloperrone.it 

closing Adobe Camera Raw, the first button to press is "LIGHT" to load the light frames, 

then we move on to loading the dark, the bias and the flat field frames. If we don't 

have all the required file types it doesn't matter, Fusion will still process the merging 

of the images. 

To make the best use of the alignment tools, it is essential to understand how they 
work and when and how to use each slider. 
Normal alignment, by itself, is capable of aligning photos with precision and speed, but 
sometimes, when this alignment is not effective, you can resort to activating the 
alignment helper. As already mentioned, this function, by varying some parameters, 
tries to make some types of photos less "indigestible", making them better aligned by 
automatic alignment, but paying a price in terms of processing time. 
If absolute precision is required, simply activate the dualpass alignment. This tool is 
extremely accurate, but also slower, based on the amount of misalignment of each 
frame. 
In summary, in order we have: 
1) Alignment - Fast and fairly accurate, but sometimes it fails to align some photos 
2) Alignment + Alignment Helper - Slightly less fast and fairly accurate, and should have 
fewer problems with some types of photos 
3) Alignment + Alignment Helper + Dualpass Alignment - Less fast but extremely precise 
4) Alignment + Dualpass Alignment - Even less fast but extremely precise 
Note: In the case of large misalignments, option 3 is faster than in case 4, but in the 
case of misalignments of a few pixels, option 4 is faster. 
According to the needs it is therefore possible to set one of the 4 configurations to 

have the desired result in the desired time. I refer you to page 29 for technical details. 

In this tutorial, we chose 5 images of the Milky Way chased with star tracker 

Skywatcher Star Adventurer for a total of 120 seconds at ISO 1600. We can activate all 

3 types of alignment or decide to activate only the first two. Next parameters to be set 

will be "ALIGNMENT PRECISION" and "MAX ALIGN RADIUS" which I set to 2 pixels to 

have a higher precision of alignment and 20 pixels the maximum radius in which it is 

possible to align two images and to avoid that some light frame. 

If you have also activated the "DUAL PASS ALIGNMENT" we have to make a small 

introduction. The "DUAL PASS ALIGNMENT" is a type of customized alignment with 

which we can decide the accuracy of the alignment. This type of alignment is activated 

by setting the maximum threshold of the stars to have a maximum alignment accuracy, 

that is by setting the slider "THRESHOLD".  

To set the threshold, proceed as follows: 

- Set the sample area of the image, without exaggerating, for "AREA WIDTH"; 
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- I press the PLACE key and go to look for an area of the sample image. In my 

case I used the planet Jupiter as a sample star for alignment; 

- Go to Image> Adjustments> Threshold, and move the slider so that you see 

the stars in a defined way (see the following image); 

 
- Once the best value is found, click on Cancel or OK (it is not influential), you 

can correctly set that value on the slider "THRESHOLD". 

- Press "CONFIRM" to confirm these parameters; 

- You can also correct lens distortion using the "LENS CORRECTION" switch and 

chromatic aberrations with the "CHROMATIC ABERRATION" switch. 

- To start image stacking press "START". 

If the images do not perfectly align, we click on the "RESET" button to reset all the 

original parameters and modify them so that the fusion is successful. 

Tip: If you are using light frames photographed with ultra-wide angle lenses and not 

starred, do not use the "LENS CORRECTION" function. 
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Tutorial DEEP SKY 
 

In this tutorial we will explain how to stack 

images of the Milky Way or deep sky using 

the DEEP SKY tab. 

In our example, we'll upload three R G B  

files, and Astro Panel will automatically 

upload files to the appropriate channels to 

create the final RGB image. 

We upload files and select AUTO 

ALIGNMENT  to ON and  ALIGNMENT TYPE 

on SHIFT as our files are not taken in the 

same way. 

ALIGNMENT CYCLES let's leave it on 3 to 

have a balanced alignment between speed 

and performance. 

At this point we click on PROCESS and wait 

for it to be processed.  
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Alignment Process of channels R G B 

Once the alignment is complete, we cut out the excess edges and regulate the colors 

with the "Selective Color Correction" tool. 
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All the material described in the guide is the property of Angelo Perrone Landscape 

Photographer. Reproduction, even partial, of images, texts or contents without 

authorization is prohibited. 

 

Thanks for reading. 
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